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ABSTRACT
Who says you can't teach an old dog new tricks? Are you an "old
dog" that is at a loss without your paper manual? Are you a "new
pup" that is just totally overwhelmed? This presentation covers
some helpful tips that the authors learned while trying to get used
to reaching for the mouse instead of the bookshelf when they
needed to look up something. Both SAS OnlineDoc® and SAS®
System Help will be covered. One question that will be discussed
- why do you need both?

INTRODUCTION
I’ve been using SAS since way back in the days of punched
cards. I actually LIKE my nice, familiar manuals. Now the boss
wants me to use all of these newfangled online gizmos instead.
Are they really worth it?
Brave new world, or comfy old one?
We do feel your pain. Some of us remember the good old days,
back before computer viruses and database marketing, when the
documentation for the entire SAS system fit into one reasonablysized volume. In fact, we understand that some veteran SAS
users still possess their copies of the SAS 79 manual. (We really
aren’t sure whether they are actually using the manuals or hope
to sell them for a large profit on eBay sometime down the road.)

and some (but not all) will also be relevant to those of you who
are running SAS with other operating systems. The examples
and tricks also assume that you are using the default access
methods for both systems: Microsoft HTML Help for the SAS
System Help, and a Java-enabled browser for the OnlineDoc.
Other ways of accessing the information in both systems are
available, but with some loss of functionality.

THE LEAP FROM VERSION 6 TO VERSION 8
I did play around a little with the Help menu items in Version 6 of
SAS. Are there big differences in Version 8?
In a word, yes.
Although Version 6 users shouldn’t have a lot of trouble adapting
to Version 8, the Help menu items are different in the two
versions, as are the underlying help system technologies that are
used.
The Help menu for SAS 6.12 is illustrated below. The main menu
entries are “Extended help” and “SAS system”. Both of these
bring up the main Help Topics dialog, with tabs for Contents,
Index, and Find. (Try as we might, we haven’t been able to find
any difference between the “Extended help” and “SAS system”
entries.) From any of these tabs, you eventually get to individual
help display pages, which with any luck will have the information
you were looking for.

Time marches on, however. And, let’s face it, it’s been a long
time since SAS software has been small and simple enough for
the documentation to fit into a single book. The many
enhancements to SAS over the years have made it a much more
powerful tool, but at the same time a more complex one. As the
capabilities of the software expanded, so too did the
documentation.
Up until a few years ago, SAS Institute used to include one
printed copy of each manual whenever it shipped a new product
or new software release. Since the male member of the authoring
team for this paper was the person at Westat who had overall
responsibility for SAS-related issues, such as fielding questions
about the capabilities of infrequently-used products, he felt
compelled to hold onto all of these manuals in case someone
might need them. The end result: over 5 feet of bookshelf space
occupied by Version 6 software documentation. He has no desire
to repeat this experience for Version 8.
So, if nothing else, the electronic documentation that is now
available is invaluable just for dealing with the sheer physical size
of the documentation in its printed form. This should be
particularly appreciated by consultants or other frequent travelers:
your laptop now can hold all of the documentation as well as the
software itself.
We hope that this paper will help you make effective use of these
modern tools. In the remaining sections, we’ll spotlight some of
the key changes between the Version 6 and Version 8 help
systems, point out some other useful sources of information for
getting started, and then describe some useful tips and tricks for
taking full advantage of the SAS System Help and the OnlineDoc.
Note that all of the specific examples and screen shots in this
paper were produced using SAS running under Windows 98.
Most of them should be applicable to other versions of Windows,

Figure 1. Help menu items in SAS 6.12.
The “Online training” item will bring up SAS/TUTOR® if you have
it licensed, while selecting “Online documentation” brings up an
initial (and very incomplete) attempt to bring some elements of
the SAS manuals online. Several of the other menu items, such
as “How to” and “SAS companion,” simply provide an expedited
way of getting to some of the individual “books” that are among
those that show up in the Contents tab of the main Extended
Help screen.
For Version 6, “Microsoft Windows Help” is the underlying
technology used. The “Find” tab was always an annoying feature
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of this system. When you first use the software, you have to wait
for it to create an index of all the words in the help system.
Moreover, the indexing process was not at all intelligent -- “all”
words included “a” and “the”, not to mention all of the variable
names used in the sample programs. Nor was the indexing
smart enough to combine differently-capitalized versions of the
same word, so you wind up with separate entries for “compress”,
“Compress”, and “COMPRESS” (not to mention “the”, “The”, and
“THE”). All in all, not one of Microsoft’s better efforts.

TO “HELP” OR TO “DOC”
OK, you’ve been talking about the “SAS System Help” and the
“OnlineDoc”, and you promised to tell me what the difference is.
So what gives?
Well, we’re not exactly sure. Much of the content of the two
systems is identical. It seems as though the SAS System Help is
primarily an evolution of the online Help found in Version 6 of
SAS, while the OnlineDoc represents a concerted effort to focus
on electronic rather than hardcopy delivery of “traditional” SAS
manuals.

Version 8, which will be covered in more detail later in this paper,
uses a much different set of Help menu items (see figure below),
as well as different technology for the system itself. The list of
menu items begins with “SAS System Help” and ends with “About
SAS System.” Several other items are in-between.

While basic syntax is covered in both systems, the OnlineDoc
frequently has more detailed and conceptual information. For
instance, the OnlineDoc has entire chapters on using DDE and
accessing external DLLs when running SAS under Windows,
while the SAS System Help mentions these topics only briefly
(although it does refer the user to the OnlineDoc for additional
information). Similarly, the OnlineDoc for PROC TABULATE
contains an extensive overview and discussion of terminology,
both of which are missing from the SAS System Help.
On the other hand, in Version 8 at least, one big advantage of the
SAS System Help is that it has more current information. If you
want to know the syntax of statements or options that were added
in Version 8.1 or 8.2 of SAS, you have to use the SAS System
Help, since the OnlineDoc was not updated for these incremental
releases.
The details of the user interface are what really differentiate the
two systems. To some extent, the choice between the HTML
Help interface used in the SAS System Help and the browserbased Java applet used by the OnlineDoc is a matter of personal
preference. However, each system offers certain concrete
advantages.

Figure 2. Help menu items in SAS 8.2.
“Using This Window” is a nice feature: as the name implies, it
brings you into the section of the SAS System Help that provides
information about the active window -- Explorer, Log, Enhanced
Editor, or whatever. “Getting Started with SAS Software” brings
up a tutorial section within the SAS System Help that explains the
SAS workspace and illustrates how to perform some basic tasks
in a point-and-click fashion.

Favorites. The main advantage of the SAS System Help
interface is that it’s much easier to mark often-used locations so
that you can go back to them easily (“Favorites”). This is very
easy to do in the SAS System Help. It’s possible in the
OnlineDoc, but only with a cumbersome and non-intuitive
procedure. We describe how to do this in both systems later in
the paper, so you can judge for yourself.

The other two items use cascading menus to access additional
types of information. “SAS on the Web” takes you to your choice
of several key pages at the SAS Institute web site (assuming of
course that you are connected to the Internet), while “Books and
Training” allows you to access either SAS OnlineTutor® (if it’s
licensed) or the SAS OnlineDoc.

Indexing. Although it’s more difficult to save Favorites with the
OnlineDoc, the implementation of this interface does have
several advantages over the SAS System Help. While both
systems let you use an index to find things in the documentation,
the indexing feature is much better implemented in the OnlineDoc
than in SAS System Help. The Master Index for the OnlineDoc
lets you quickly get to the section of the index beginning with a
particular letter, and each index entry includes a code indicating
what manual the entry is found in. The OnlineDoc also lets you
browse through the index of a single manual -- so, if you want to
look for something specifically in the context of SAS macro, you
can easily restrict yourself to the index entries in the SAS Macro
Language Reference. In contrast, all the SAS System Help lets
you do is to either find (by typing) or scroll to a particular entry in
a single index list. Its index also seems to be less complete: we
were not successful in finding an entry for the KEYLABEL
statement in PROC TABULATE, for instance.

Fortunately, the “missing” items from the Version 6 Help menu
(mostly) haven’t been lost in Version 8, just relocated:
Version 6 Help menu item
Keys
How to
SAS companion

Sample programs
Tech Support
What’s new

Utility application

Version 8 equivalent
In Options submenu under
Tools
Various -- mainly in the “SAS
Software Tutorials” book
“Using SAS Software with Your
Operating Environment” book in
the Contents tab
“Sample SAS Programs and
Applications” book
In the “SAS on the Web” Help
submenu
“What’s New in ...” items in the
“Welcome to the SAS System”
book
Apparently no longer supplied in
this form

Searches. Similarly, the Search facility in OnlineDoc is much
more flexible (not to mention faster) than its counterpart in the
SAS System Help. As with indexing, you can either search the
entire OnlineDoc, subsections of the documentation (e.g., just
documentation for Base SAS), or just particular books. In
addition to just searching for an individual word, you can choose
to find all entries containing any of the words you specify, all of
the words, or the exact phrase. There is also a syntax for
specifying advanced search criteria. As an additional bonus, the
search results are grouped by manual, with a shaded icon used
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to highlight the most relevant results.

MARKING YOUR TERRITORY WITH “FAVORITES”

In the SAS System Help, the Search capabilities are much more
limited. You cannot limit the sections of the help information that
are searched, and you can’t specify the type of search that is
done. (If you enter more than one word, only those pages
containing all of the words listed are returned.) The results are
returned in alphabetical order by the name of the page, which
makes it almost impossible to separate the wheat from the chaff
when a large number of hits are found.

There is some bad news and some good news about the SAS
System Help. The bad news is that it’s not always easy to find
certain key locations: you may need to do quite a bit of
navigating. The good news is that, once you’ve found an
interesting page, you don’t have to go to all that trouble again to
get back to it later. That is, if you take advantage of the Favorites
tab.
Let’s say, for instance, that you frequently need to check on the
syntax of the procedures in Base SAS (don’t we all). You’ve
heard through the grapevine that all of the PROCs are listed on a
single page, in linkable form, and you set out to find that page.

Navigation. Finally, the OnlineDoc offers more in the way of
built-in hyperlinks for navigation. Nearly all pages have links for
Chapter Contents (or Book Contents), Previous, and Next at the
top and bottom. This feature makes it extremely easy to
sequentially work your way through a topic, such as all of the
options for a particular statement. The OnlineDoc seems to do a
better job of linking to examples and to information outside the
current topic. For instance, the discussion of procedure syntax
for PROC REPORT in the OnlineDoc includes links to ODS
documentation, statements that can be used in multiple
procedures, and global statements. To be completely honest,
though, neither system implements hyperlinking nearly as fully as
it should. The PROC REPORT syntax page just mentioned also
lists all of the procedure’s statements, both alphabetically and by
function, but neither list includes hyperlinks to the full
documentation of the statements. Here the SAS System Help
actually does a better job.

GETTING THE LAY OF THE LAND
Is there anyplace else I should check for more tips on how best to
use these systems?
Both the OnlineDoc and SAS System Help include information
about how to make best use of the system. It’s well worth a few
minutes of your time to take a look at this material.
For the OnlineDoc, just use the Help tab. You can click on the
“Quick Tour” button for a brief but complete presentation of the
system. Or, you can select from among the various specific
topics listed. If you like having full control of your searches,
select “using an advanced query” to get a full explanation of the
conventions used for logic operators, proximity conditions, and
threshold conditions.
To get (brief) information about using the SAS System Help,
select the Contents tab, expand “Welcome to the SAS System”
(the first topic listed), then expand “Getting Help in SAS
Software”.

Figure 3. List of Base SAS Procedures.
Now, wasn’t that fun? Drilling all the way down to find that nugget
was a fair amount of work -- there must be an easier way.
(Apparently this particular exercise comes up a lot -- the path to
this page is documented in SAS Note SN-001643.) Fortunately,
the SAS System Help provides a simple way of flagging
important pages for easy access later. Just find the page once,
then click on the Favorites tab. Ideally the Current Topic text box
at the bottom will contain a meaningful label for the page
(although sometimes it may just contain a cryptic URL-type
address). No matter -- if you don’t find the current label
sufficiently mnemonic for you, simply change it, then click the
Add button. Presto, you’re set! The next time you get into the
SAS System Help and need to get to that page, just click on the
Favorites tab, then double-click on one of the topics you’ve saved
to go directly to that page.

The SUGI 25 paper by Jim Ashton, Sean Gargan, and Dee
Stribling provides a useful overview of getting SAS information
online, including the SAS System Help and OnlineDoc.
The SAS Institute web site has a nice summary of the OnlineDoc
at http://www.sas.com/service/doc/cdrom/v8pdf/faq.html. It
notes, among other things, that the OnlineDoc contains over
21,000 pages of reference documentation from 45 books (which,
not incidentally, would cost over $2,000 in printed format).

BEST NEW TRICKS -- “HELP” DIVISION
So, what are some good tricks for using the SAS System Help?
Oops -- that IS what we promised, isn’t it? Here are several, from
the simple to the complex.
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Simply typing HELP is equivalent to selecting the Using This
Window item from the Help menu (or pressing the F1 key, or
clicking the Help icon on the standard toolbar). The real fun
comes when you type something after HELP.
For instance, this is a great way to hone in on help for a particular
SAS product. Type HELP SAS/GRAPH, for instance, and you
will magically be transported directly to the main help page for
SAS/GRAPH® software.
You can also get directly to the help information for a particular
SAS procedure, if you know the secret. The intuitive HELP
PROC MEANS, unfortunately, doesn’t work. HELP MEANS
PROCEDURE, however, does. Abbreviating PROCEDURE to
PROC will work with some, but not all, procedures. (Don’t ask us
why -- we didn’t design it. Nor can we guarantee that even the
full form works with all PROCs.)
The Help information for the SAS System Help suggests that you
can also follow the word HELP with certain other key words, such
as FORMATS or FUNCTIONS. Most of these work (although
SYSTEMOPTIONS didn’t seem to).
KEEPING EVERYTHING IN CONTEXT
If, like us, you often need help with SAS procedure syntax, you
can also get context-sensitive help from the Enhanced Editor
window. So, if you’ve just typed in PROC TABULATE and now
find yourself at a loss, simply make sure the cursor is somewhere
within the word TABULATE, and press the F1 key. This will not
only bring up the SAS System Help, but will bring you to the main
page for the PROC in question.

Figure 4. Using the Favorites tab.
IGNORE THE “LOCATE” BUTTON
Both of us were mightily puzzled by the Locate button, and the
corresponding item in the View menu labeled Locate Topic in
Contents. Our theory was that the button was intended to
synchronize the arrangement of the Contents tree on the left with
the topic currently showing on the right. Occasionally this
worked, but more often it didn’t seem to do much of anything at
all.

On occasion this technique will work with SAS keywords other
than procedure names, but don’t count on it.
HAVE IT YOUR WAY® (PART 1)

The folks at SAS Institute Technical Support were kind enough to
explain what was going on. Our theory about what Locate was
supposed to do was in fact correct. The problem is that most
individual pages within the SAS System Help do not correspond
directly to Table of Contents entries -- so if one of these pages is
the current topic, Locate doesn’t do anything.

We’ve already talked about the most important way you can
customize your SAS System Help experience, which is to add
your most-used pages to the list in your Favorites tab. This
section will cover two other ways you can set things up to get
quick access to especially pertinent sections of the help material.
Both of these take advantage of the capability of adding an
argument to the HELP command.

So, save yourself some frustration and just leave Locate alone.
Defining a key. As you may know, the SAS Display Manager
lets you assign one or more commands to function keys or
certain other keystroke combinations. Thus, in addition to having
the F1 key by default bring up help for the current window, you
can define other key combinations to get to particular portions of
the SAS System Help. Maybe you would like to be able to press
F12 and be sent directly to the main help page for PROC
TABULATE. Simply type KEYS in the command bar to bring up
the Keys window, type HELP TABULATE PROCEDURE in the
Definition area opposite F12, and issue the File, Save command.
That’s all there is to it!

MAKING THE BEST OF SEARCH
As we discussed above, the search facilities in the SAS System
Help are not nearly as flexible as those in the OnlineDoc,
particularly in terms of controlling how the search is carried out
when you enter multiple keywords. You can, however, use
quotation marks to search for a specific phrase. If you enter
missing value (with no quotation marks) into the search keyword
box, the system will find all pages that contain both of the words
you specified, but not necessarily next to each other. If you’re
only interested in “missing value” as a phrase, you can surround
it with double quotation marks in the text entry box so that the
search engine will only return pages containing that phrase.

Defining a Toolbar button. In a similar fashion, you can
associate a HELP command string with a button on your Toolbar.
Select Customize from the Tools menu, activate the Customize
tab, and click the Add Tool button. Type HELP TABULATE
PROCEDURE into the Command text box, and enter appropriate
text for the Help Text (which shows up in the message area at the
lower left of the SAS window when the cursor is pointing to the
tool) and the Tip Text (which displays a short button description
when you place the cursor over the toolbar button). Click the
Change Icon button to select an appropriate icon. If you like, use
the Up and Down arrows to change the location of your button on

LET YOUR FINGERS DO THE WALKING
Some of us “old dogs” still find that the best way to get from Point
A to Point B sometimes is just to type a little, rather than pointing
and clicking. Fortunately for us geezers, the SAS command bar
allows us some useful shortcuts into the SAS System Help.
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the toolbar. Click OK, and you’re done!

The HELPREGISTER system option is the way to do this. Like
some other SAS options, HELPREGISTER must be specified at
SAS invocation or in your SAS configuration file: it cannot be
used in an OPTIONS statement. One way to do this is to add the
HELPREGISTER information to the end of the command line for
your SAS icon, although you wind up with a very long command
line that is cumbersome to view and edit. A more reasonable
choice is to specify this option in a configuration file. A complete
discussion of the ins and outs of SAS configuration files is well
beyond the scope of this paper, but you can look it up in
OnlineDoc. (The SAS System Help contains only a limited
discussion of this topic.)
HELPREGISTER requires 2 arguments, although you will more
often use it with three or four:
1. Menu string -- Quoted text string, which will be displayed in the
menu.
2. Help file location -- The physical file or URL containing the
desired help information.
3. Help string -- Quoted text string, which will appear on the
status line when the menu item is highlighted
4. Topic -- The specific section within the help file that you want
to display.
Let’s take a quick look at a set of 3 HELPREGISTER entries as
they might appear in a configuration file:

Figure 5. Adding a new Toolbar button.

-helpregister
"SAS Procs"
F:\sas82\SAS\core\help\base.chm
"SAS Procedures Index"
"/base.hlp/sashelp_index.htm"

HAVE IT YOUR WAY (PART 2)
Warning Warning Warning -- the following section is for intrepid
and advanced users only! Messing with your SAS configuration
file or with the properties of your SAS icon is not for the faint of
heart. Whatever you do, be sure to make a backup copy first.
(We, the authors, cannot be held responsible for any direct or
consequential damages!)

-helpregister
"Analyst App"
F:\sas82\SAS\core\help\analyst.chm
"Help for the Analyst Application"
"/analyst.hlp/main_contents.htm"

Adding items to the SAS Help menu. If adding keyboard
shortcuts or toolbar buttons doesn’t meet your needs (or satisfy
your craving for adventure), you can actually add items to the
SAS Help menu in order to easily access specific sections within
Help. Using this technique, you don’t have to remember which
keystrokes you assigned, or which toolbar icon stands for a
particular favorite Help page: you simply pull down the Help menu
and select what is presumably a clearly-labeled item.
Furthermore, you can get to ANY page within the SAS System
Help, not just those that can be reached via a HELP command
argument.

-helpregister
"PROC TEMPLATE FAQ"
http://www.sas.com/rnd/base/topics/
templateFAQ/Template.html
"FAQ for PROC TEMPLATE"
The first two entries add menu items that point to specific
locations within the SAS System Help, while the third example
points to a file on the SAS Institute web site. (In real life, the
complete URL needs to go on a single line.) When using
standard HTML files, the Topic argument can specify an anchor
name (e.g. Inherit) to point to a specific location within the
document.
OK, I understand that, but how do I figure out the Help File
Location and Topic within the SAS System Help?
Under Windows, the SAS system help is stored as HtmlHelp
compiled help (.chm) files. Particular topic pages within these
files are referenced using a path-type location that closely
resembles a partial URL.
To figure this out for a particular topic, navigate to the topic of
interest in the SAS System Help, right-click somewhere on the
right pane, and select Properties. You should get a dialog
window that looks something like this:

Figure 6. Customized Help menu.
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STARTING OFF ON THE RIGHT FOOT
While you can easily get to the OnlineDoc from within SAS itself
(just select Books and Training, SAS OnlineDoc from the Help
menu), many of us operate in an environment where we don’t
necessarily have interactive SAS running at all times on our
computers. (In fact, some folks may run SAS only on a server
and not use it on the desktop at all.) We may be much more
likely to keep our web browsers running all day, however.
Therefore, it makes a lot of sense to save the URL of the opening
page of the OnlineDoc in the list of Favorites (or bookmarks) in
your browser. This lets you get to the documentation quickly,
without having to open up SAS if it’s not already running.
GETTING USED TO THE INDEX
Although the indexing provided with the OnlineDoc is quite
flexible, the interface can be a little confusing until you get used
to it. This is because things work differently, depending on
whether you are using the Master Index, or the index for an
individual book.

Figure 7. Finding the address of a Help page.
We are interested in the section labeled Address: (URL).
Highlight the entire contents of that field -- you will almost
certainly need to scroll to get the whole thing -- press Ctrl-C to
copy it to the clipboard, and paste it into your text editor. You will
get something like the following:
mk:@MSITStore:F:\sas82\SAS\core\help\base.chm
::/base.hlp/sashelp_index.htm
This starts out with some stuff at the beginning that you don’t
need to worry about (the mk:@MSITStore:). The portion after
that up to the two colons is the Help File Location, which
becomes the second argument of your HELPREGISTER
specification. The section after the two colons represents the
Topic, which is argument #4 for HELPREGISTER.

Figure 8. Using the Master Index.
When you are using the Master Index (see figure above), the
actual index entries appear in the right-hand pane of the window.
The entries are grouped into pages by starting letter, with a link to
the page for each letter at the top of each set of entries. Once
you’re on the proper page, you can scroll until you find what
you’re looking for, or take advantage of your browser’s Find
command.

A couple other minor notes are worth mentioning. At least with
the machine we were trying things out on, the SAS System Help
window that came up for our customized Help menu entries
lacked a menu bar, although there was a menu bar in the SAS
System Help application started up by the built-in menu items
(such as SAS System Help). Second, the SAS System Help and
the OnlineDoc information for HELPREGISTER suggest some
shortcuts that can be used when specifying the file location.
These didn’t work for us: we had to specify the exact location of
the help file to get things to work.

Each index entry includes a link, which is the abbreviation of the
book that contains the entry. The scrollable area in the left pane
contains a cross-reference list of abbreviations and book titles.
Thus, looking at the entry for “Y Axis Vertical” above, we see that
this entry is from the “INSIGHT” manual, which the left pane tells
us represents the SAS/INSIGHT® User’s Guide. You can type
into the Find box on the left to scroll the list of abbreviations and
manuals to the proper place.

BEST NEW TRICKS -- “DOC” DIVISION
My head is spinning. How about some nice easy tricks for the
OnlineDoc?
We’ll try.
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You can use wildcard characters in any OnlineDoc search, not
just in advanced queries. An asterisk represents zero or more
characters, while a question mark matches exactly one character.
You may not begin a word with a wildcard character, however.
TAKE ADVANTAGE OF THE NAVIGATION
The OnlineDoc provides quite a few handy ways of getting
around. Depending on the task and your own personal
preferences, either Contents, Index, or Search can be a good
way to get started. Beyond that, the first page in each book and
chapter generally provide a very nice overview of its contents,
with links to each subsection or topic.
As we noted above, most of the individual topic pages have links
for Chapter Contents (or Book Contents), Previous, and Next at
the top and bottom, which makes it very easy to move
sequentially through a related set of material. And, of course,
you can always use the Back button in your browser to retrace
the steps you followed to get to a particular place.

Figure 9. Using the index for a specific book.

SAVING FAVORITE PAGES WITH ONLINE DOC

To use the index for a particular book, click on the “Index for...”
button, navigate to the desired manual, and click OK. (To return
to the Master Index, click on the button and then click on the icon
for Master Index.) In this mode, the index entries are in the left
pane rather than on the right: to find a particular entry, either start
typing text in the Find box or use the vertical scroll bar. Once you
find a useful entry, click on it and the desired information will
appear in the right-hand pane. (Before you click on any entries,
the right pane still contains whatever was there before, which can
be somewhat confusing.)

We saw in our discussion of the SAS System Help how easy it
was to quickly return to often-needed pages of information, once
they had been added to the Favorites tab. Unfortunately, there is
no Favorites tab in the OnlineDoc, so that simple approach is not
available to us. Of course, we are operating in a browser
environment, so the browser itself has a “Favorites” or
“Bookmarks” facility that we ought to be able to use. Because
the OnlineDoc uses HTML frames, however, even that is not a
simple undertaking. Just following the usual Add Favorites
procedure does not work reliably.

USE LOWERCASE TEXT FOR SEARCHES

We have had more success with the (albeit much more
convoluted) procedure below:

If you want the OnlineDoc search facility to find all occurrences of
your keyword(s) regardless of capitalization, be sure to enter
them in all lower case. Words containing any capital letters are
treated as case-sensitive. For instance, entering “PACKED”
produces 8 matches, while “Packed” produces 22, and “packed”
results in 79.

1. Save the page as a Favorite the way you normally would. Be
sure to give it a meaningful and unique name.
2. Right-click on the page in question (right pane) and select
Properties from the pop-up menu.
3. Drag over the entire Address field to highlight it, and press
Ctrl-C to copy the URL to the Clipboard.
4. Click OK to close the Properties dialog, and select Organize
Favorites from the Favorites menu.
5. Navigate to the item you just added, right-click it, and select
Properties.
6. Delete the current contents of the URL field and hit Ctrl-V to
paste in the URL that you just copied to the Clipboard.
7. Click OK, then Close.

Of course, there are times when you may actually want your
search to be case-sensitive. In particular, you can take
advantage of the SAS documentation convention of putting
language keywords in all uppercase. Searching for “REMOVE”,
for instance, produces a manageable 26 hits, while searching for
“remove” results in 200 matches (which seems to be the most
that the system will return per search).
ADVANCED SEARCHES

When you use one of these Favorites items, the topic will fill the
entire browser, rather than just the right pane, so you will not
have immediate access to the Contents, Index, and Search tabs.
We recommend that you add the “home page” of the OnlineDoc
to your Favorites in the normal manner, so that you can select it
at any point to return to the normal HTML frame environment.

The OnlineDoc’s Search tab provides considerable flexibility in
specifying your searches. Using the “Look for:” dropdown box,
you can specify whether you want to find all pages with “at least
one word in list,” or just those with “all the words in list.” You can
also choose to treat your entry as a “phrase” or an “advanced
query.”

If you usually keep your Windows desktop visible, an easier
approach is to right-click on the page of interest and select
Create Shortcut from the pop-up menu. This will create a
shortcut on your desktop, which you can double-click later to get
back to the desired page. As with the first technique we
described, the topic will then fill the entire browser.
Unfortunately, the shortcut file will get a meaningless name when
created (e.g., z0309877.htm), so you will want to go back to the
shortcut file before you forget what it is and give it a more
meaningful name. The main disadvantage of this approach, for
us anyway, is that it is much less convenient to access desktop
shortcuts, as opposed to ones that are actually on the Favorites

The advanced query feature lets you include keywords and
parentheses in your queries to specify logic, proximity, and
threshold conditions. Let’s say you want to find out what features
SAS software has related to calendars, other than those in PROC
CALENDAR or some other PROC. You could try specifying an
advanced query like calendar AND NOT (proc OR procedure) to
eliminate the many PROC CALENDAR hits that a simple search
for calendar would produce. Don’t forget to specify “advanced
query” in the “Look for:” box.
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menu.

Also, don’t forget that you can, if you like, purchase a printed
copy of nearly all of the SAS manuals that are included in the
OnlineDoc.

SHARE YOUR DISCOVERIES

NOT QUITE UTOPIA

The technique described above for getting the “full URL” of an
individual topic page within the right-hand pane of the OnlineDoc
can also be used if you’d like to share a useful page with others,
either in an e-mail or in some other document. (Of course, the
others with whom you’re sharing will have to either be running the
OnlineDoc from the same intranet or have an identical local
installation for the URL to work.) Simply follow steps 2 and 3
above, and when you’re done paste the URL into your message
or document.

The SAS OnlineDoc overview claims that “you can locate
information quickly and easily.” I beg to differ.
Let’s say, for example, you are new to SAS and you’ve been told
to “impute the missing values by carrying the last value forward.”
How easy will it be to figure out how to do this using the
OnlineDoc?
To be honest, probably not very easy. Using “impute,” “missing
values,” “carry forward,” and “last value” as search strings (asking
to find both words but not necessarily as a phrase) wouldn’t
produce anything very useful. You might eventually have more
success by going to the Contents tab, drilling your way down to
Statements in SAS Language Reference: Dictionary, and then
taking a look at the statement names. Seeing RETAIN might
suggest that this could be the key to your assignment. (Of
course, if you had known from the beginning that you needed to
use RETAIN and just needed to figure out the details, things
would have been much easier.)

IT’S EVERYWHERE, IT’S EVERYWHERE!
Let’s say you wake up some night at 3 AM with a blinding flash of
inspiration that may solve the nagging SAS problem you’ve been
working on for days. You just need to check one thing in the
documentation ... but of course, that’s on your intranet at work.
You know you won’t be able to get back to sleep without
confirming that your idea will work -- what’s a SAS programmer to
do?
Well, if you have a home computer and an Internet connection,
you’re in luck. Just point your browser at www.sas.com/v8doc.
This page will let you register for free access to the OnlineDoc
from the SAS Institute web site, for those times when you’re at
home or otherwise away from your usual copy of the online
documentation.

It’s probably fair to say that the information that can be located
most “quickly and easily” in the SAS System Help and the
OnlineDoc is that which relates to particular statements and other
elements of the SAS language. Other information that is more
conceptual certainly is included in the OnlineDoc -- for example,
in the SAS Language Reference: Concepts book. To make the
best use of this information, it pays to become familiar with the
different manuals that are available through the Contents tab, and
with the chapters of the ones that are most relevant to you. You
may want to bookmark or even to print out a couple of the key
Contents page for easy reference.

PROCURE THE PDF
One legitimate complaint that many folks have about HTML is
that printing is not its strong suit. For one thing, page breaks are
usually pretty arbitrary. More importantly, while it’s relatively easy
to print off a single page from a web browser, it’s tedious in the
extreme to print off an entire set of related pages if you need
offline access.

Still, the SAS System Help and OnlineDoc should not be viewed
as the best or only way to figure out how to do things in SAS -there are certainly many other alternatives for learning SAS
software in general, or figuring out how to accomplish a particular
task. After all, according to the FAQ for the OnlineDoc on the
SAS Institute web site, “Research shows that the best type of
technical information to put on CD-ROM is the reference material
--- dictionary- or encyclopedia-style information. Users indicate
that they prefer hardcopy format for how-to and example-type
technical material.”

The version of the OnlineDoc that is shipped with SAS software
comes in HTML format. You can also purchase (for a very
reasonable price) a separate CD-ROM that contains the same
material in Adobe’s Portable Document Format (PDF) files, one
file per book chapter. Since Acrobat Reader makes it very easy
to print an entire chapter, or even a subset of consecutive pages,
this is certainly a worthwhile investment if you haven’t completely
achieved a paperless state of mind.

CONCLUSION
The SAS System Help and the SAS OnlineDoc have come a long
way from Version 6 to Version 8, and we expect that the
electronic help and documentation features will be even better in
Version 9 of the SAS system. Whether you’re an “old dog” or a
“new pup,” learning some of the basic tips and more advanced
tricks for using these systems should significantly improve your
efficiency and productivity in using SAS software.

PEACEFUL COEXISTENCE
Well, you started out telling me about these fancy electronic,
paperless tools, and now you’re telling me to get the material in
PDF so I can print some of it out. Are we going around in circles
here?
Not necessarily.

DISCLAIMER
All opinions stated are the opinions of the authors and may not
reflect the opinions or intent of SAS Institute.

Just because SAS now has some innovative ways of getting
information electronically doesn’t mean you have to abandon
hardcopy entirely. Maybe you’d like to print out the table of
contents for some of the electronic manuals you refer to most
often, or make a paper copy of a few key reference pages so you
can keep them close at hand. Particularly with the PDF edition of
the OnlineDoc, it’s very easy to print out an entire chapter’s worth
of material so you can take a look at it at home or while traveling
(not while driving please!).
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